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安全性未審査の組換え DNA 技術応用食品の検査方法 
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Ⅰ．検体採取方法 
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1. 亜麻、コムギ、コメ、トウモロコシ、ナタネの検体採取（略） 
 
 
2. パパイヤ及びバレイショばれいしょの検体採取 
2.1. 生鮮のパパイヤ及びバレイショばれいしょの検体採取 
 
生鮮のパパイヤ及びバレイショばれいしょの検体採取については、対象となるロットの

大きさに応じて以下の表に従い検体採取を行う。 

ロットの大きさ 検体採取のための開梱数 検体採取量（個） 

 ≦ 50  2 2 
51 ～ 500  3 3 

501 ～ 35,000  5 5 
 ≧ 35,001  8 8 

 
 
2.2. パパイヤ及びバレイショばれいしょの加工食品の検体採取 
 
パパイヤ及びバレイショばれいしょの加工食品の検体採取については、対象となるロッ

トの大きさに応じて 1.2.2.の表に従い検体採取を行う。なお、果汁・飲料製品、氷菓等製

品については、検体採取量を 480 g とする。また、パパイヤ又はバレイショばれいしょの

含有量が少ない加工品について実施する場合は、製品分類ごとに複数回の前処理試行が可

能となるよう適宜検体採取量を増やして採取すること。 
 

 

検査原則 

当検査は、生鮮及び種々の加工食品が検査対象検体として想定されるため、その性状に

より測定結果は変動する。これらを縮小するための原則について記す。  

・ 検査対象検体は、一検体数を一単位とする。  

・ 原則として、検査対象検体の食さない部分を廃棄した可食部を試料とする。（例えば、生

鮮のパパイヤについては種子・果皮を除いた果肉部分、バレイショばれいしょについて

は皮を除いた塊茎部分） 

・ 試料中の成分は、不均一に分布すると考えられるため、検査に供する前に試料全量を粉

砕器等*で十分に破砕し、均質混和して調製試料とする。  

・ 検査に供する調製試料は固体や液体の性状に関わらず、重量測定にて一定量を採取する。  

・ 試料調製を含む検査全般は、空気の動きがなく温度・湿度の変動が少ない区切られた空

間で行い、コンタミネーションを防ぐよう実施する。  

・ 微量測定のため、粉砕用器具*容器、秤量用器具、凍結乾燥瓶は中性洗剤等で洗浄後、ア

ルカリ洗剤に一晩浸け置きする。あるいは超音波洗浄機を用い、30分間の超音波処理を

行う。  
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* レッチェGM200（レッチェ社製）、ミルサー（イワタニ社製）、Force Mill（大阪ケミカル社製）、

Xtreame Blender（Waring社製）、磁製乳鉢・乳棒および同等の結果が得られるものを用いる。 

 
 
3. その他 
 市販の亜麻、コメ、ナタネに関しては、検体採取量は検査を繰り返し行うのに十分の量と

する。  
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Ⅱ．個別検査方法 
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亜麻（FP967）の検査方法（略） 
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コムギ（MON71800）の検査方法（略） 
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コムギ（MON71700 及び MON71800）の検査方法（略） 
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コメ（63Bt、NNBt、CpTI）の検査方法（略） 
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コメ（LL601）の検査方法（略） 
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トウモロコシ（Bt10）の検査方法（略） 
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トウモロコシ（CBH351）の検査方法（略） 
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トウモロコシ（DAS59132）の検査方法（略） 
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ナタネ（RT73 B. rapa）の検査方法（略） 
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パパイヤ（PRSV-YK、PRSV-SC、PRSV-HN）の検査方法（略） 
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バレイショばれいしょ（E12、F10、J3）の検査方法 
 
バレイショばれいしょ含有食品を検査対象として、1検体から2併行でDNAの抽出精製を

行いDNA試料液を得る。そのDNA試料液を用いて、遺伝子組換えバレイショばれいしょ23
系統（E12、F10、J3）をそれぞれ検知するリアルタイムPCRを使用した検査を行う。 
 
 
1. DNA抽出精製 
 
バレイショばれいしょ含有食品は様々な形態が想定されるため、本試験法では生鮮バレ

イショばれいしょ（通常食するバレイショばれいしょの塊茎）を例に試料前処理及びイオ

ン交換樹脂タイプのDNA抽出精製キット*（QIAGEN Genomic-tip 100/G）を用いたDNA抽出

精製法を記す。 
 

* DNA抽出精製は、キアゲン社製Genomic-tip 100/G又は同等の性能（収量及び精製度）を有するDNA抽

出精製キットを使用することができる。 
 
 
1.1. 試料前処理 
 
生鮮バレイショばれいしょの塊茎は、水でよく洗浄後、皮を剥いた上で、芽の出てくる

「目」付近を中心に約 30 g を採取する。加工品は、分別可能な場合、バレイショばれいし

ょのみを採取する。最後にフードプロセッサー等*1 を使用し、均質に粉砕したもの*2 から

DNA 抽出精製を行う。 
 

*1 フードプロセッサー等、試料前処理に用いた器具は全てコンタミネーションを防ぐため、市販の DNA 
ZAP（Ambion 社、Cat. No.AM9890）又は同等の効力を持つ製品を用いて DNA 分解処理したものを

用いる。 
*2 実験に使用せず残った試料は、ポリプロピレン製遠沈管（50 mL 容）に移し冷凍庫（-20℃）で保管

することができる。 
 
 

1.2.試料からの DNA 抽出精製 
1.2.1. DNA の抽出精製（陰イオン交換樹脂タイプキット法[QIAGEN Genomic-tip 100/G]） 
 
粉砕した試料からの DNA の抽出精製は、イオン交換樹脂タイプの DNA 抽出精製キット

（QIAGEN Genomic-tip 100/G）を用いた改変法を使用する。詳細は以下のとおりである。

試料は、ポリプロピレン製遠沈管（50 mL容）に 8 g*1量り採り、G2緩衝液*2 20 mL、α-amylase*3 
20 µL、RNaseA*4 20 µL と cellulase*5 500 μL を加える。サンプルがチューブの底に残存しな

いようボルテックスミキサーで激しく混合し、50℃で 1時間保温する。保温している間、2
～3 回遠沈管反転させて混和する。さらに、Proteinase K*6 200 µL を加え、再び 50℃で 1時
間保温する。その間 2～3 回遠沈管を反転させて試料を転倒混和する。次いで、8,000 x g、
4℃で 20 分間遠心分離し、得られた上清を、あらかじめ QBT 緩衝液*2 4 mL を用い平衡化

した QIAGEN Genomic-tip 100/G に負荷する*7。一回の遠心で上清がうまく採取できない場

合は、8,000 x g、4℃で 10 分間遠心分離し、できる限り採取する。次いで、チップを QC
緩衝液*2 で 7.5 mL ずつ 3 回洗浄した後、カラムを新しい遠沈管に移し、QF 緩衝液*2 3 mL
を負荷し、DNA を溶出する。次いで、イソプロパノールを 3 mL 添加してよく混合する。
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マイクロチューブ（1.5 mL 容）4～6 本に均等になるように移し、遠沈管を遠心分離機で軽

く遠心し残りも均等になるようにマイクロチューブに移す。13,000 x g、4℃で 20 分間遠心

し、上清を廃棄した後、-20℃で冷却した 70%（v/v）エタノール 1 mL を加え、さらに 13,000 
x g、4℃で 10 分間遠心した後、上清を破棄し、残った沈殿を乾燥させる。水 55 µL を一つ

のマイクロチューブに加えて沈殿物を溶解させ、その溶解液全量を別のマイクロチューブ

に移し入れ、よく混合し、この作業を繰り返して全てのマイクロチューブから沈殿物を溶

解させ、抽出 DNA 原液とする。 
 

*1 バレイショばれいしょデンプン（例: 片栗粉など）やバレイショばれいしょデンプンを加工した製品

（例: 春雨など）は、DNA 含有量が少ないので注意する。抽出 DNA 原液の濃度が 10 ng/μL に達しな

い場合は、改めて抽出を行い、2 回の抽出を合わせた DNA 原液（110 µL）に対して 1/10 倍量の 3 M
酢酸ナトリウム溶液（11 µL）と 2.5 倍量の-20℃で冷却したエタノール（275 µL）を加え DNA をエタ

ノール沈殿させ、13,000 x g、4℃で 20 分間遠心し、上清を廃棄した後、-20℃で冷却した 70%（v/v）
エタノール 1 mLを加え、さらに 13,000 x g、4℃で 10 分間遠心した後、上清を破棄し、残った沈殿を

乾燥させる。水 55 µLで沈殿物を溶解させ抽出 DNA 原液とする。それでも 10 ng/μLに達しない場合

は、抽出 DNA 原液をそのまま DNA 試料液として用いる。 
*2 G2 緩衝液、QBT 緩衝液、QC 緩衝液及び QF 緩衝液はキアゲン社製キット（Cat. No. 19060）に付属し

ているが、足りない場合には単品で購入するかキットの説明書に従って調製可能である。 
*3 α-amylase（高純度品）はニッポンジーン社製のもの又は同等の活性を持つものを用いる。 
*4 RNase A はキアゲン社製のもの（100 mg/mL、Cat. no. 19101）又は同等の効力をもつものを用いる。 
*5 cellulase はシグマアルドリッチ社（Cat. no. C2730-50ML）のもの又は同等の効力を持つものを用いる。 
*6 Proteinase Kはキアゲン社製のもの（20 mg/mL、Cat. no. 19133）又は同等の効力をもつものを用いる。 
*7 沈殿物や上層の膜状の部位を取らないようにする。また、沈殿物が見えない場合でも、遠沈管内の底

部付近にはできるだけ触れないように、上清を負荷する。 
 
 
1.2.2. DNA試料原液中のDNAの純度の確認並びにDNA試料液の調製と保存  
 

DNA試料原液の適当量を取り、滅菌蒸留水を用いて適宜希釈*1し、200～320 nmの範囲で

紫外部吸収スペクトルを測定し、260及び280 nmの吸光度*2（A260及びA280）を記録する。次

いでA260の値 1 を50 ng/μL DNAと換算し、DNA濃度を算出する。またA260/ A280を計算する。

この比が1.7～2.0になれば、DNAが十分に精製されていることを示す*3。得られたDNA濃度

から、DNA試料原液を滅菌蒸留水で希釈して10 ng/μLに調製し、DNA試料液とする。DNA
試料液は55 μLごとにマイクロ試料管に分注後、-20 °C以下で冷凍保存する。分注したDNA
試料液は、融解後直ちに使用し、残った溶液は再度保存せず廃棄する。なお、2回の抽出を

合わせたDNA試料原液の濃度でも10 ng/μLに達しない場合は、そのままDNA試料液として

用いる。 
 

*1 希釈する場合には、滅菌蒸留水を用いる。また、希釈倍率は、吸光度測定装置により適切な測定に要

する液量及び濃度域が異なるため、適宜とする。 
*2 A260が DNA 由来の吸光度、A280がタンパク質等不純物由来の吸光度と考える。 
*3 A260/ A280の比が1.7～2.0の範囲外であっても精製等の更なる操作は要さない。 
 
 
2. 定性リアルタイムPCR法 
 
遺伝子組換えバレイショばれいしょ23系統（E12、F10、J3）検知試験用として、E12、

F10、J3それぞれの系統に特異的に導入されている配列を検知するプライマー・プローブを
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用いる。バレイショばれいしょ陽性対照試験は、バレイショばれいしょ由来Adenine 
Phosphoribosyl Transferase（APRT）遺伝子を検知するプライマー・プローブを用いる。検知

用プライマー対及びプローブは以下の塩基配列のものを滅菌蒸留水に溶解し使用する。 
 

・E12検知試験用プライマー対、プローブ 
E12 F: 5’-TAGTTGGGAGTAGGCTTTATAC-3’ 
E12 R: 5’-GATAAAATGGATAAAAACAGATC-3’ 
E12 P: 5’-FAM-CGAGTTGGACTACGGTCAGTCACTTTGTACTAG-TAMRA-3’ 
 
・F10検知試験用プライマー対、プローブ 

F10 F: 5’-GAAGCTATAACAATAACTGGTCC-3’ 
F10 R: 5’-CACACACTTCGTTTACAC-3’ 
F10 P: 5’-FAM-TATATATCCTGCTGGACCAGTTG-TAMRA-3’ 
 

・J3検知試験用プライマー対、プローブ 
J3 F: 5’-ATCAAAACCGGTACTCAAATTT-3’ 
J3 R: 5’-GAGTTGTCAAATGTGAATTTATTTC-3’ 
J3 P: 5’-FAM-CAACAGGACAACCACAAGCTAGGAAACTCAC-TAMRA-3’ 

 
・バレイショばれいしょ陽性対照試験用プライマー対、プローブ 

APRT F: 5’-TGAAAACGATCCCGATCG-3’ 
APRT R: 5’-CAATCCCAGCGATACGTTC-3’ 
APRT P: 5’-FAM-TGGCGCCTCATGATCCG-TAMRA-3’ 

 
 
2.1. PCR用反応液の調製 
 

PCR用反応液は25 μL/wellとして調製する。組成は以下のとおりである。FastStart Universal 
Probe Master (ROX)*1 12.5 μL、対象プライマー溶液（各プライマー、50 μmol/L）各0.4 μL、
対象プローブ溶液（10 μmol/L）0.25 μLを混合し、DNA試料液5 μLを添加し滅菌蒸留水で全

量25 μLに調製する。PCRのブランク反応液として、必ずDNA試料液を加えないものについ

ても同時に調製する*2。分注操作終了後、真上からシール*3し、完全にウェルを密閉する。

このとき、しわが寄らないよう注意し、専用のシーリング用アプリケーターを用いて行う。

最後にウェルの底を観察し、底に気泡がある場合は、プレートの縁を軽く叩いて気泡を抜

いておく。プレートの確認後、MicroAmp Optical Cover Compression Pad*4を茶色の面が上に

なるよう、プレートの上面にセットする。 
DNA試料液あたりバレイショばれいしょ陽性対照試験と遺伝子組換えバレイショばれ

いしょ（E12、F10、J3）検知試験をそれぞれ2ウェル併行して行うものとする。 
 

*1 FastStart Universal Probe Master (ROX) 
本試薬は粘性が高いため、混合操作を行う際には、混合が確実に行われるように注意する。不十分な

場合には、PCR がうまくいかない場合がある。使う直前には必ず軽く攪拌後、遠心し、溶液を試料

管の底に集めておいてから使用する。なお、撹拌操作はボルテックスを使用すると泡立ってしまうた

め、ピペッティング又は転倒混和することで静かに行う。また、ウェルに分注する際は、以後撹拌、

遠心が困難なことを考慮し、ウェルの底に確実に入れる。 
*2 Non-Template Control（NTC） 

DNA 試料液の添加の際、NTC には DNA 試料液の代わりに滅菌蒸留水をウェルに 5 μL添加する。 
*3 96 ウェルプレート、シール及びシーリングアプリケーター 



 

 20

ABI PRISM 7900HT 又は ABI 7500 を使用する場合は、MicroAmp Optical 96-Well Reaction Plate（Life 
Technologies 社）及び ABI PRISM Optical Adhesive Cover（Life Technologies 社）を使用する。LightCycler 
96 又は 480 を使用する場合は、LightCycler®480 Multiwell Plate 96 又は LightCycler 8-Tube Strips(white)
（LightCycler 480 の場合は LightCycler 8-Tube Strip Adapter Plate を用いる。）（ロシュ・ダイアグノ

スティックス社）を使用する。 
シーリングの詳細については製品付属のマニュアルを参考のこと。 

*4 MicroAmp Optical Cover Compression Pad（Life Technologies 社）は、ABI PRISM 7900HT の場合のみ使

用する。ABI 7500 又は LightCycler では使用しない。 
 
 

2.2. リアルタイム PCR による測定 
 
以下、ABI PRISM 7900HT、ABI 7500、LightCycler 96 又は LightCycler 480 を使用した操

作方法を記述するが、上記 4 機種と同等の性能を有するものも使用可とする。 
 
 
2.2.1. ABI PRISM 7900HT  
 
① オペレーション用 PC の電源を入れ、起動させる。PC が完全に起動してから ABI 

PRISM 7900HT 本体の電源を入れ、30 分以上ウォーミングアップしたのちに反応を開

始する。 
② デスクトップ上のアプリケーション [ABI PRISM 7900 SDS Software] をダブルクリ

ックして開く。メニューバーの [File] → [New] を選択し、{New Document} ダイアロ

グを表示させる。{Assay} は [Absolute Quantification (Standard Curve)]、{Container} は 
[96 Wells Clear Plate]、{Template} は [Blank Template] を選択し、[OK] ボタンをクリ

ックする。 
③ メニューバーの [Tools] → [Detector Manager] を選択し、{Detector Manager} ダイア

ログを表示させる。[New] ボタンをクリックし、{Add Detector} ダイアログを開く。

Detector の設定は、E12、F10、J3 系統及び APRT ともに Reporter を [FAM]、Quencher
は [TAMRA]となるように設定し、[OK] ボタンをクリックする。{Detector Manager} 
ダイアログ上で使用する Detector（バレイショばれいしょ陽性対照試験、各検知試験）

を選択し、[Copy To Plate Document] ボタンをクリックし、[Set Up] タブ上に使用す

る Detector を登録し、最後に [Done] ボタンをクリックする。 
④ 画面左上枠で各ウェルを選択し、右枠の [Set Up] タブ上で、Detectorが [バレイシ

ョばれいしょ陽性対照試験]又は [各検知試験（E12、F10、J3）] の行の {Use} 欄に

チェックを入れる。次にウェルごとに {Task} 欄でそれぞれの情報（Non-Template 
Control：NTC、測定対象検体：Unknown）を選択し、{Sample Name} フィールドにサ

ンプル番号を入力する。{Passive Reference} が [ROX] に設定されていることを確認

する。 
⑤ [Instrument] タブ上の [Thermal Profile] よりサーマルサイクラー条件を以下のよう

に設定する。[50℃, 2 分 → 95℃, 10 分 → (95℃, 15 秒 → 55℃, 1 分) ×45 サイクル] 
⑥ {Sample Volume} を[25 L] に設定し、{9600 emulation モード} にチェックが入って

いることを確認する。 
⑦ 設定条件をプレートドキュメント（.sds）として保存する。 
⑧ [Instrument] タブ上の [Connect] ボタンをクリックし、PC と ABI PRISM 7900HT 本

体を connect 状態にする。[Instrument] タブ上の [Open / Close] ボタンをクリックし、
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ステージを装置本体から出し、2.1.で調製した 96 ウェルプレートの切欠き部を右上に

してステージ上に載せる。再び [Open / Close] ボタンをクリックし、96 ウェルプレー

トを装置本体にセットする。 
⑨ [Instrument] タブ上の [Start] ボタンをクリックし、反応とデータの取り込み（所要

時間：約 2 時間）を開始する。 
 
 

2.2.2. ABI 7500  
 
① オペレーション用 PCの電源を入れ、起動させる。PCが完全に起動してから ABI 7500

本体の電源を入れ、30 分以上ウォーミングアップしたのちに反応を開始する。 
② デスクトップ上のアプリケーション [7500 System Software] をダブルクリックして

開く。メニューバーの [File] → [New] を選択し、{New Document} ダイアログを表示

させる。{Assay} は [Absolute Quantification (Standard Curve)]、{Container} は [96 Wells 
Clear]、{Template} は [Blank Template] 、{Run Mode} は [9600 emulation]を選択し、

[NEXT] ボタンをクリックする。 
③ Detector の設定は、E12、F10、J3 及び APRT ともに Reporter が[FAM]、Quencher は

[TAMRA]、とし、[ADD] ボタンをクリックする。{Passive Reference} が [ROX] に設

定されていることを確認し、[NEXT] ボタンをクリックする。 
④ 画面下枠で各ウェルを選択し、上枠で、Detectorが [バレイショばれいしょ陽性対照

試験] 又は [E12、F10、J3、APRT 検知試験] の行の {Use} 欄にチェックを入れる。

次にウェルごとに {Task} 欄でそれぞれの情報（Non-Template Control：NTC、測定対

象検体：Unknown）を選択し、[FINISH] ボタンをクリックする。 
⑤ [Setup] タブ上の各ウェルをダブルクリックし、サンプル名を入力する。 
⑥ [Instrument] タブ上の [Thermal Cycle Protocol] よりサーマルサイクラー条件を以下

のように設定する。[50℃, 2 分 → 95℃, 10 分 → (95℃, 15 秒 → 55℃, 1 分) ×45 サイ

クル]。 
⑦ {Sample Volume} を[25 L] に設定する。 
⑧ 設定条件をプレートドキュメント（.sds）として保存する。 
⑨ 2.1. で調製した 96 ウェルプレートの切欠き部を右上にして、装置本体のステージ上

に載せセットする。 
⑩ [Instrument] タブ上の [Start] ボタンをクリックし、反応とデータの取り込み（所要

時間：約 2 時間）を開始する。 
 
 

2.2.3. LightCycler® 96  
 
① LightCycler 96 本体の電源を入れ、セルフテストが完了して起動するまで約 5 分待機

する。 
② LightCycler 96 本体タッチパネル右の[New] をタッチし{Create New Experiment}を表

示させる。[New experiment based on Roche template] から [RunTemplate_Hydrolysis 
Probe_Amp] を選択し、{Experiment Name}を入力して[Create]する。 

③ [Run Editor] タブの[Measurement]タブで、{Reaction Volume( l)} を[25] に設定する。 
④ [Run Editor] タブの[Profile]タブでサーマルサイクラー条件を[95℃, 10 分→ (95℃, 15

秒→55℃, 1 分) x 45 サイクル]と設定する。55℃の Step の Acquisition Mode が[Single]
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となっていることを確認する。 
⑤ [Eject]をタッチしてローダーを出し、2.1. で調製した 96 ウェルプレートの切欠き部

を右下にして、サーマルブロック上にセットして閉じる。 
⑥ 本体画面右上の [Start] をタッチし、反応とデータの取り込みを開始する。 
⑦ 反応の終わったファイルを LC96 Application Software で開く。 
⑧ [Sample Editor] タブ画面を表示し、右側の 96 ウェルフォーマット図で 32 
種類の遺伝子組換えバレイショばれいしょ（E12、F10、J3）検知試験及びバレイショば

れいしょ陽性対照試験のウェルを選択し、Gene の{FAM}欄に検出する遺伝子名を入

力する（一度入力すると、プルダウンから選択する事が出来る。）。 
⑨ 次にウェルごとに  Sample の{Type} 欄で、それぞれのサンプルタイプ（Negative 

Control 又は測定対象検体：Unknown）を選択する。 
⑩ 96 ウェルフォーマット図の各ウェルを選択し、Sample の{Name}欄にサンプル名を

入力する（一度入力すると、プルダウンから選択する事が出来る。）。 
 
 

2.2.4. LightCycler® 480  
 
① LightCycler® 480 本体の電源を入れ、セルフテストが完了して起動するまで約 5 分待

機する。オペレーション用 PC の電源を入れ、起動させる。 
② デスクトップ上のアプリケーション  [LightCycler480 SW] をダブルクリックし、

[User Name]と[Password]を入力してソフトを立ち上げる。 
③ [New Experiment from Template] をクリックし{Create Experiment from Template}の一

覧から [Mono color HydrolysisProbe-UPL] を選択し、OK する。 
④ [Run Protocol] タブで、{Reaction Volume} を[25] に設定し、サーマルサイクラー条

件を次のように設定する。[95℃, 10 分 → (95℃, 15 秒 → 55℃, 1 分) x 45 サイクル→ 
40℃,30 秒] と設定する。55℃の Step の Acquisition Mode が[Single]となっていること

を確認する。 
⑤ Save をクリックし設定条件を保存する。 
⑥ 本体のプレートローディングボタンを押してプレートローダーを出し、2.1. で調製

した 96 ウェルプレートの切欠き部を右下にしてセットした後、再度ボタンを押して

プレートローダーを格納する。 
⑦ [Start Run] をクリックし、反応とデータの取り込みを開始する。 
⑧ （反応中に）[Subset Editor]にて、（+）ボタンから New Subset を作成し、サンプルを

セットしたウェルを選択した後 Apply をクリックする。 
⑨ [Sample Editor]にて、Step1: [Select Workflow]で Abs Quant を選択する。Step2: [Select 

Samples]内の[Subset]のプルダウンメニューから、⑧で作成した Subset を選択する。

Step3: [Edit Abs Quant Properties]で、各ウェルを選択し、[Sample Name]を入力し、

{Sample Type} 欄でそれぞれの情報（Negative Control 又は測定対象検体：Unknown）
を選択する。 

 
 
3. 結果の解析と判定（図1参照） 
 
遺伝子組換えバレイショばれいしょ（E12、F10、J3）検知試験及びバレイショばれいし

ょ陽性対照試験のいずれについても、結果の判定はAmplification plot上で指数関数的な増幅
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曲線とCt（Cq）値の確認及びmulticomponent上での対象色素由来の蛍光強度（FAM）の指

数関数的な明確な増加の確認をもって行う。 
 
 

ABI PRISM 7900HT又はABI 7500を使用した場合のデータの解析 
① メニューバーの [Analysis] → [Analyze] を選択する。 
② 画面右枠の [Result] タブをクリックして {Amplification Plot} 画面を表示させる。 
③ {Amplification Plot} 画面上の {Plot} 欄で [ΔRn vs Cycle] を表示させ、ベースライ

ンを 3 サイクルから 15 サイクルで設定し、{Threshold} 欄に [0.2] と入力する。 
④ {Amplification Plot} 画面上の {Detector} 欄で [All] を選択する。表中に Ct 値が表

示される。 
 

LightCycler 96を使用した場合のデータの解析 
① [Analysis]タブをクリックし[Add Analysis] を選択し{Create New Analysis}ウィンドウ

を表示させる。[Abs Quant]を選択し[OK]をクリックする。 
② [Amplification Curves]に増幅曲線が、[Result Table] に Cq 値が表示される。 

 
LightCycler 480を使用した場合のデータの解析 
① [Analysis]ボタンをクリックし{Create new analysis}にて、[Abs Quant/2nd Derivative 

Max] を選択し [Subset] プルダウンから作成した Subset を選択し [OK]をクリック

する。 
② 表示された画面で、[Calculate]をクリックする。 
③ 増幅曲線と、[Result Table] に Cq 値が表示される。 
 
2併行抽出より得られるDNA試料液の判定は、1抽出あたり2ウェル併行で測定を行い、

合計4ウェルすべてを用いて判定する（E12系統を判定する場合は、E12系統検知法の2併行

4ウェル、F10系統を判定する場合は、F10系統検知法の2併行4ウェル、J3系統を判定する場

合は、J3系統検知法の2併行4ウェル。）。 
 
E12、F10、J3の判定：（図1参照） 

DNA試料液において、 
（１）バレイショばれいしょ陽性対照試験の2併行すべてのウェルで43未満のCt（Cq）値

が得られ、かつ遺伝子組換えバレイショばれいしょ（E12、F10、J3）検知試験い

ずれかの試験ともすべてのウェルで43未満のCt（Cq）値が得られた場合、当該試

料は遺伝子組換えバレイショばれいしょ陽性と判定する。 
（２）バレイショばれいしょ陽性対照試験の2併行すべてのウェルで43未満のCt（Cq）値

が得られ、遺伝子組換えバレイショばれいしょ（E12、F10、J3）検知試験のすべ

てのウェルで43未満のCt（Cq）値が得られない場合には、当該試料は遺伝子組換

えバレイショばれいしょ陰性と判定する。 
（３）バレイショばれいしょ陽性対照試験の2併行すべてのウェルで43未満のCt（Cq）値

が得られ、遺伝子組換えバレイショばれいしょ検知試験で2ウェルの結果が一致し

ない場合は、粉砕・均質後の当該試料から改めて2回目のDNA抽出精製を行い、

さらに「2. 定性リアルタイムPCR法」以降の操作を実施して、判定を行う。2回目

のDNA試料液を用いた場合でも一致した結果が得られない場合には、遺伝子組換

えバレイショばれいしょ陰性と判定する。 
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2併行抽出のそれぞれの抽出DNA試料液（各2ウェル）について、結果の判定スキームに

従って判定し、両方の抽出DNA試料液（合計4ウェル）について陽性と判定された検体を

陽性と判断する。 

 
  
 
 なお、上記判定により遺伝子組換えバレイショばれいしょ陽性が判定された結果につい

てmulticomponentを解析し、目視でFAMの蛍光強度の指数関数的な増加が観察でき、ROX
の蛍光強度の明確な下降やFAMの蛍光強度の緩やかな上昇がないことを確認する。 

また、バレイショばれいしょ陽性対照試験のすべてのウェルで43未満のCt（Cq）値が得

られないDNA試料液については、再度、粉砕・均質後の当該試料から改めて2 回目のDNA
抽出精製を行い、さらに「2. 定性リアルタイムPCR法」以降の操作を行い、それでもバレ

イショばれいしょ陽性対照試験のすべてのウェルで43未満のCt（Cq）値が得られない場合

には、本試料からの検知は不能とする。 
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＋／＋ ＋／－ or －／－

DNAの抽出精製以降を再操作(2回目)

＋／－ or －／－

検知不能

図１ 結果の判定スキーム

STEP2

＋／＋ －／－ ＋／－

陽性 陰性

＋／＋

陽性 陰性

DNAの抽出精製以降を再操作（2回目）

F10又はJ3検知試験*

STEP1

－／－ ＋／－or

バレイショ陽性対照試験*

*注:ブランク反応液で増幅が見られた場合は、
コンタミネーション等が疑われ、適切な検査が
行われていなかったことを示す。

＋／＋
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行われていなかったことを示す。
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Ⅲ．検査方法の同等性確認方法（略） 
 

 


